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Introduction 

Congratulations on upgrading to Future Impact software version 4.5 — the most 
significant update in the long history of the Future Impact. New devices ship with v4.5 
pre-installed, and owners of any Future Impact V4 or V4 VIP model can install it free of 
charge. 
 
This addendum assumes you are already familiar with the fundamentals of the FI V4. If 
you need a refresher, the complete FI User Guide V4.11 is available in the Help menu 
of the Editor software and on our website. To avoid duplication, this document focuses 
exclusively on what is new or different in v4.5, and notes where behaviour diverges from 
V4.11. 
 

What's New in V4.5 

• FM Sound Engine: 99 Yamaha DX7-compatible FM programs.  
FM sounds are routed through the FI's VCF and Effect sections (Chorus, Delay, 
Overdrive, EQ). Throughout this document, the existing 99 sounds are referred to 
as VA (Virtual Analogue) and the new sounds as FM. 

 
• Setlists: Programme any combination of VA and FM programs into an ordered 

performance list — no computer required. On stage, step through them one by 
one with a footswitch. 

 
• Pitch Tracking Priority — Zero Latency: A new third option, Zero Latency, 

joins the existing Speed and Accuracy modes. It can be applied to most VA and 
FM programs for instant response. 

 
• Portamento: Now available in Bass/Guitar mode, in addition to the existing MIDI 

mode. 
 

• Copy and Swap VA Programs: Reorder programs, or copy a single program to 
multiple slots to create variations of it; this can now be done directly on the pedal, 
without the Editor. 

 
• Restore Factory Defaults: Restore VA or FM programs to their original factory 

state at any time, without the Editor. 
 



• Automatic Input Mode Switching: The FI now detects which input (audio or 
MIDI) you are using on the first note and automatically reboots into the correct 
input mode (BASS/SPLIT/GTR or MIDI). 

 
• Separate MIDI Channels: Assign separate MIDI channels for Internal mode 

(keyboard or controller input) and External mode (VA programs driving an 
external synthesizer). 

Installation 

Important: Even if you have installed FI updates before, read this section in full 
before proceeding. 
 

• Download and install the Editor v4.5 on your PC or Mac. It installs as a separate 
application alongside your existing V4.11 Editor — keep both, as you will need 
the old Editor if you ever connect to a V4 device running firmware earlier than 
v4.5. 

 
• The firmware installation replaces the factory sound set with 99 new VA 

programs and 99 new FM programs. If you have created any of your own 
VA programs, save them to your computer using the new Editor in the first 
step of the upgrading process. If you have only ever used the original factory 
programs, you can skip this step with Cancel — the original V4 sound set is 
available for download from our website at any time. 

 

Step-by-Step Installation 

1. Connect a USB MIDI interface to your computer. 
2. Launch the new v4.5 Editor. 
3. Go to MIDI/Preferences; select your MIDI interface both for FI Input Device and 

FI Output Device.  
4. Connect the FI to the MIDI interface with two MIDI cables:  

MIDI OUT of the MIDI Interface -> MIDI IN on the FI 
MIDI OUT of the FI -> MIDI IN on the MIDI Interface. 

5. Select File/Firmware Update from the Editor menu bar.  
6. You will see a popup notification asking if you want to make a backup of your VA 

programs; follow the instructions, or press Cancel to continue if you do not need 
a backup. 

7. Start your FI in Update Mode: keep both footswitches pressed while connecting it 
to the 9V power. The ON LED will start to blink slowly.  

8. The next popup notification asks you to ensure the pedal is in update mode; as 
your pedal already is, press OK.  

9. Select the BUNDLE450.fi4 file.  
10. Press Open. The ON LED will blink rapidly as the download begins. Progress is 

shown in the upper-left corner of the Editor. The process takes under two 
minutes, after which the LED returns to a slow blink. 



Before the FI is ready to use, all parameters must be initialized via the Global 
menu as detailed in the following steps. 

11. Disconnect the power and turn the Parameter selector to the leftmost position, 
Note Off Level. 

12. Keep only the left footswitch pressed while powering the device on again.  
“GLb” appears briefly, then the display shows “InS”.  

13. Press the left footswitch once; the display shows “ini”.  
14. Turn the Parameter selector one step to the right, Note On Level. The display 

shows blinking “---“.  
15. Turn the Edit wheel clockwise until the display shows blinking “ALL”.  
16. Press the Edit wheel button. The display blanks briefly, then returns to showing 

blinking “---”. 
17. Press the right footswitch briefly; the FI is now ready to use. 

 

Getting Started with V4.5 

After a successful installation, the display shows 01, indicating VA sound engine mode 
with Program 01 active. Press the ON/OFF footswitch to enable the effect, then set your 
levels: 
 

• Adjust INPUT LEVEL so that only the hardest pick attacks briefly illuminate the 
red LED. 

• Set OUTPUT LEVEL to balance the synthesizer sound with the true-bypass 
signal in the OFF state. 

 
The 99 VA programs include precise emulations of the synth bass lines from 13 classic 
tracks — "Chameleon", "Thriller", "Hysteria", "Pony", and more — alongside funky and 
R&B tones, and the complete original Deep Impact sound set. 
 

Switching to FM Sounds 

Enter Global and navigate to the InS (Instrument) parameter — the Parameter selector 
must be at Note Off Level. Move the selector to Note On Level; the display shows bS.A 
(Bass Guitar, VA engine). Turn the Edit dial one step clockwise to switch to bS.F (Bass 
Guitar, FM engine). Press ON/OFF to return to Direct Play mode and explore the 99 FM 
programs. 
 
In FM mode the display shows the program number with the first decimal point lit — for 
example 0.1 — to indicate FM mode. 
 
The FM library draws heavily from iconic 1980s and 1990s recordings made with the 
Yamaha DX7 bass: "Take on Me", "Smooth Criminal", "Take My Breath Away", "Broken 
Wings", and many more. You will also find funky bass, smooth bass, double bass, 
Stratocaster emulation, and a selection of classic DX7 sounds — church organ, tubular 
bells, pan pipe, harmonica, and others. 



 

Using VA Sounds with a MIDI Keyboard 

In Global, navigate to InS mode and turn the Edit dial until Snt (Synthesizer) appears. 
The second decimal point will now be lit — e.g. 01. — to indicate Synthesizer mode. 
While a MIDI note is held, the first decimal point also lights temporarily. 
 
Editing programs and writing Parameter Edits using the Parameter selector and Edit dial 
works exactly as described in the FI User Guide V4.11 (hereafter: U.G.). 
 

Detailed Reference 

Global Menu 

The Global Menu has been significantly revised since V4.12. All menu items are listed 
below; only new or changed items are described in detail. Items marked "As in U.G." 
are unchanged, except where noted in parentheses. 
 
Navigation note: To step through the Global Menu list, the Parameter selector must 
always be at Note Off Level. In addition, toggling the Gate output is inhibited at all menu 
steps except those that affect CV/Gate settings (CV Scale, CV Fine Offset, CV 
Semitone, CV Octave Offset).  
The Global menu always opens at the most-recently-accessed menu item. 
 
Instrument Mode (Ins) 

Values: bS.A Bass + VA | bS.F Bass + FM | SP.A Split + VA | SP.F Split + FM | Gt.A 

Guitar + VA | Gt.F Guitar + FM | Snt MIDI Synth | EUI EWI/Wind MIDI.  

Default: bS.A. 

 
Initialize (ini) 

Resets factory defaults. Unlike Instrument Mode, a selection must be confirmed by 
pressing the Edit button — the display blinks as a warning that data will be overwritten. 
This replaces the earlier rS (reset) option. 

Values: --- (warning; no action) | Glb Global parameters | Set Setlist (steps 1–50: VA, 

51–99: FM) | Pt.A VA parameters | Pt.F FM parameters | FP.A VA factory programs | 

FP.F FM factory programs | ALL Everything. 

 
MIDI Channel — Internal (CH.I): As in U.G. (Formerly CHA). 

 
MIDI Channel — External (CH.E) 

Values: 1–16. Default: 1. Sends Program Changes, MIDI note messages, and Pitch 
Bend on this channel. 
 
VCF Control Range (uCF): As in U.G. 



Tune Base (tbS): As in U.G. 

MIDI Thru (trU): As in U.G. 

Output Mode (OUt): As in U.G. 

CV Scale (Cu.S): As in U.G. 

CV Fine Offset (Cu.F): As in U.G. 

CV Semitone Offset (Stn): As in U.G. (Formerly SEt.) 

CV Octave Offset (OCt): As in U.G. 

 
Autoswitch Mode (AtS) 

Values: OFF / on. Default: OFF. When enabled, the FI detects whether you are playing 
via audio input (modes bS.A, SP.A, Gt.A) or MIDI input (Snt, EUI) on the first 

incoming note, and automatically switches to the appropriate mode. 
Beware if you are editing a VA sound for bass, and you use the option to test notes from 
a MIDI keyboard. In this case turn off Autoswitch, otherwise the FI will not stay 
permanently in audio-triggered VA mode.  
 
Setlist Range (SEt) 

Values: SL2 / SL3. Default: SL2. A setlist step can use one of three sound-engine 
modes: audio-triggered VA,  MIDI-triggered VA, or audio-triggered FM. Selecting SL2 
restricts the setlist to the two most common modes (audio-triggered VA and audio-
triggered FM), simplifying programming. 
 
Copy and Swap (CPY) 

Copy or Swap VA programs directly on the device: 
• Select Copy/Swap: a right-arrow flashes for Copy; turn the Edit dial to show a 

double-arrow for Swap. After selecting the desired function, press the Edit button. 
• SRC appears for Source. Turn the Edit wheel to select the source between 

01…99. Press Edit to confirm. 
• dSt appears for Destination. Turn the Edit wheel to select the destination 

between 01…99. When you press Edit again, a three-pass animation confirms 
the action. The menu then returns to the Copy/Swap symbol so you can repeat 
the operation. 

 
Cancelled automatically if: (1) you press the encoder while SrC or dSt is displayed 
without making a selection, or (2) the source and destination programs are the same. 
 
Any stored edits to the nine sound Parameters are preserved during the copy/swap 
process so that programs sound identical when moved to a new location. 
 
Copy and Swap is available for VA programs only. 

  



Using Setlist 

The setlist contains 99 steps. Each step can recall any VA (Bass), VA (MIDI) or FM 
program in any order. 
 
Entering Setlist mode: With the Parameter selector in either of the first two positions 
(Note Off Level or Note On Level), long-press the Edit button. Long-press again to 
return to Direct mode. Setlist mode is indicated by three horizontal dashes on the 
rightmost display digit. 
 
In steady state, the display shows the program number of the sound you are currently 
hearing — not the step number. Each time a program changes, the step number is 
displayed for 1.6 seconds (the three dashes disappear briefly), then the display reverts 
to the program number. For example, scrolling from step 1 to step 10 shows 1, 2, 3 … 
10, then after 1.6 seconds it switches to the program number stored in step 10. 
 

• All methods of changing programs used in Direct mode (step up/down, scroll, 
backstep, received PC commands) work identically in Setlist mode — but here 
they advance through setlist steps rather than programs directly. Incoming MIDI 
Program Change messages address setlist step numbers, not program numbers. 

• Setlist mode is stored in memory; if you power off in Setlist mode, the FI powers 
on in Setlist mode. 

• On power-on, the setlist always starts at step 1. 
• Activating Setlist mode mid-session also starts at step 1. 
• Deactivating Setlist mode returns to the default/user-defined startup program. 
• Automatic mode-switching between audio and MIDI inputs is disabled in Setlist 

mode, since the setlist defines each step's mode explicitly. 
• The Tuner is available in Setlist mode, just as in Direct mode. 
• MIDI Program Change output in Setlist mode follows the same rules as in Direct 

VA and FM modes: for a VA program without an embedded MIDI option, the 
program number is sent; for a VA program with an embedded MIDI option, the 
embedded PC number is sent; for an FM program, the program number is sent. 

 

Programming the Setlist 

While in Setlist mode, the Edit wheel is used to set both the sound-engine mode and the 
program for each step. 
 
Navigate to the step you want to programme using the Program footswitch or an 
external MIDI controller. Press the Edit wheel to cycle through the three available 
sound-engine modes, indicated by the decimal points: 
 

1. VA with audio input (bS.A, SP.A, Gt.A): no decimal point is lit. 
2. VA with MIDI input (Snt, EUI): the second decimal point is lit, and the first 

decimal point blinks in response to a MIDI Note-On message. 
3. FM with audio input (bS.F, SP.F, Gt.F): the first decimal point is lit. 



 
With SL2 selected in Global (the default), mode 2 above is suppressed. SL3 makes all 
modes available. Once the desired sound-engine mode is selected, turn the wheel to 
audition and choose a program — the last decimal point flashes to indicate an unsaved 
change. When you find the desired sound, press the wheel to store it; the flashing 
stops. 
 
Auto-cancel: If you do not press the wheel within 20 seconds, or if you press the 
Program footswitch, the FI discards the change and reverts to the original program. The 
selected engine mode, however, is retained. 
 

• Both audio-triggered VA and audio-triggered FM each have sub-modes for bass, 
split, and guitar. Once you select a sub-mode for either engine, the FI 
remembers it. Switching back to that engine in Setlist mode recalls your last sub-
mode automatically. 

• A short delay occurs on every program change in Setlist mode to keep behaviour 
consistent when switching between VA and FM. This is normal. 

 

 

Fine-Tuning Setlist Levels 

Even a well-balanced setlist may need per-program level or tonal adjustments. Here is 
the recommended workflow: 
 

1. Set up the full setlist with the Parameter selector in the leftmost position. 
2. Step through the setlist from the beginning. When a program is too loud or too 

quiet, move the Parameter selector to Level (or another parameter), adjust with 
the Edit wheel and store with the Edit button. 

3. If you want to store this change permanently in the program file then press the 
Edit button for three seconds. The number will start to blink. Release the button 
and press it again briefly. The new Program is stored, and Parameters are reset 
to zero. 

CV and MIDI Triggering 

CV/Gate control of external analogue synthesizers works in FM mode just as in VA 
mode with audio input exactly as described in U.G.  
MIDI Triggering works in VA mode just as before. In the 4.12 software version the first 
four programs contained demo settings for external MIDI. Now the same demo settings 
are included in the first four Deep Impact compatible sounds, 21…24.  
MIDI Triggering is not available in FM mode.  

Portamento 

Portamento was previously only available in VA mode with MIDI input. In v4.5, it is also 
supported with bass or guitar audio input. 



 
• For Portamento Slope only RATE is implemented, TIME is not. 
• For Portamento Mode both LEGATO and ALWAYS are implemented. 
• Portamento affects both the internal synth engine and CV/Gate output. It does 

not send MIDI Portamento messages to external synthesizers — configure 
portamento on the external synth separately. 

• Portamento is not available in the FM sound engine. 
 

Editing FM Sounds 

Editing FM programs on the pedal works almost identically to editing VA programs. The 
only difference is that the Dynamics parameter controls velocity offset in the FM 
engine (instead of VCF frequency, as it does in the VA engine). 
 

Pitch Tracking Priority 

The Pitch Tracking Priority parameter previously offered two modes — Speed and 
Accuracy — as described in U.G. V4.5 adds a third mode: Zero Latency (displayed as 
Zero in the Editor), which can be applied to most programs for the fastest possible 
response. The selected mode is also applied to the MIDI and CV outputs in VA. 
 

MIDI in FM Mode and Setlist Mode 

MIDI Out 

In FM mode, MIDI output is not used to control external synthesizers. It only sends 
Program Change messages on each program change. 
 

MIDI In 

Incoming PC messages 1–99 switch between the 99 FM programs, just as in VA mode. 
 
Switching between VA and FM via MIDI: Send a BANK LSB message before the 
Program Change: 

• BANK LSB 0 sets VA mode 
• BANK LSB 1 sets FM mode. 

 
Because switching between VA and FM requires reloading the operational program, the 
FI cannot receive MIDI for approximately 0.2 seconds after a BANK LSB message. To 
avoid dropped messages, send the PC before the BANK LSB — in that order, no delay 
is needed. 
 
In Setlist mode, incoming PC messages step through the setlist, which can contain any 
mix of VA and FM programs. The same 0.2-second window applies when a PC triggers 



a VA/FM mode switch. Scrolling with the PROGRAM footswitch works exactly as in 
Direct VA or FM mode (scroll speed is slightly reduced to prevent accidental skips). 
 
The following chart lists all received Controllers that are implemented in FM. In some of 
them there are slight differences between the different modes of the FI, these are 
described in the table. 
 
 
 

Receiving MIDI CCs 
 in VA(audio) in VA(MIDI) in FM in Setlist 

BANK LSB 0 change to FM --- --- --- 

BANK LSB 1 --- --- change to VA --- 

CC 1 VA vibrato VA vibrato FM vibrato VA or FM vibr. 

CC 7 volume volume volume volume 

CC 11 filter cutoff filter cutoff filter cutoff filter cutoff 

CC 67 down, scroll down, scroll down down 

CC 88 up, scroll up, scroll up up 

CC 69 toggle on/off toggle on/off toggle on/off toggle on/off 

CC 74 filter cutoff filter cutoff filter cutoff filter cutoff 

 
 

 

V4.5 FI Editor software 
 

Due to the introduction of the FM synthesis engine, several changes have been made 
throughout the editor. The main body of the editor has not changed, and you can find 
full documentation in the current full user guide (Version 4.11), pages 28–89. 
 
 

The Manager 

In the Bank Commands section, two new buttons appear on the left where the NEW 
button was. With NEW VA and NEW FM, you can select between the two synthesis 
engines. The FI V4 pedal will switch to the appropriate mode, and the Manager’s 
functions will work on that part of the library (pedal, local, and online directories). There 
are two LED signals next to these buttons, the selected mode is indicated by a red light.  
You can carry out all Bank Commands and Program Commands functions on FM 
patches the same way as with VA patches. 
 
In the Program Commands section, there are new subcategories under the Edit 
column (SONG, DEEP, SYNTH, BASS-FX). These apply to the BASS category only. 
 
The header of the File Commands section hasn’t changed, but the browser behaves 
differently depending on the selected synthesis engine. FM sounds use a new file 



format with the .pr4fm extension. These contain both the sysex data of the FM sound 
and the FI parameters for that sound. The browser will show only this type of file when 
you are in FM mode. The other shown type is FM (DX7) bank sysex files with the .syx 
extension. These appear as directories; when you double-click one, it opens and 
displays the 32 patches in that bank with their original names. You can select one, 
several, or all patches and drag them to empty tiles on the right. 
 
 

The Editor 

The most obvious changes appear when you switch to Editor mode in FM mode. The 
left part of the Editor (the four oscillators) is gone and replaced by a new FM editor 
section. While the editor is not a full FM editor (you can use third-party editors for that), 
several important parameters and pieces of information are included. 
 
The uppermost window shows the original program name of the imported sysex file 
and a graphic representation of the algorithm used. This addendum does not teach FM 
synthesis, but some basics are needed if you want to modify FM sounds. 
 
This kind of FM synthesis (basically the original DX7 type) uses six operators. The 
operator shown on the bottom line in green is the carrier. Depending on the algorithm, 
you can have more carriers. Operators on the subsequent lines in blue are modulators. 



There is always at least one operator in each sound that has a loop around its number; 
this signals the feedback part of the FM sound. Basically, the carrier operator carries the 
base frequency and volume, and the modulator operator modifies it with frequency 
relations and levels. It can be more complicated than this, with fixed-frequency 
operators and other behaviors. 
 
The next part of the FM editor handles the LFO parameters of the FM sound. Under the 
LFO header, the first three sliders of six are common to both pitch and amplitude 
modulation: SPEED, DELAY, and WAVEFORM. SPEED and DELAY have adjustable 
values in the 0–99 range and behave similarly to the original LFO FRQ and DELAY 
parameters from the VA engine. The WAVEFORM slider selects among six waveforms; 
the waveform name is shown at the top of the slider. 
 
Pitch modulation is handled by two sliders: PITCH DEPTH and PITCH SENS. You must 
set a non zero value (1–7) on PITCH SENS to use PITCH DEPTH effectively (PITCH 
DEPTH ranges 0–99). Pitch Sensitivity controls the amount of Modwheel data (CC1) 
sent to the LFO section as well. The Modwheel takes precedence if its value is higher 
than the PITCH DEPTH setting. To have vibrato only be introduced via a MIDI pedal, 
set PITCH DEPTH to zero and PITCH SENS to a higher value. 
 
The AMP DEPTH slider (0–99) works in tandem with the OP AMP MOD SENSITIVITY 
section, where you can set independent values (0–7) for each operator. Depending on 
the operator type, the effect can be volume modulation (tremolo) or a filter-like 
modulation. 
 
The OP OUTPUT LEVEL / FEEDBACK section is where you can significantly modify 
FM sounds. Depending on the algorithm and values, you can alter tones considerably. 
Modifying a carrier operator’s level primarily changes that part’s volume; modifying 
certain operators can produce filter-like behavior, but results vary. By studying the 
algorithm structure you can remove part of a sound by zeroing the level of a carrier 
operator if there is more than one. When experimenting, write down or photograph the 
original settings—minor changes can produce major sound differences. The FBCK 
slider sets the feedback amount (0–7), often creating a distorted or metallic part of the 
sound. 
 
The next section is VELOCITY. Here you can fine-tune the dynamic behavior of the FM 
sound relative to the playing instrument. This is important because original DX7 sounds 
respond well to played MIDI dynamics. (Originally, each operator had an independent 
Key Velocity parameter.) OFFSET sets a middle value for key velocity, while AMP 
controls the amplitude of the dynamic-to-velocity conversion. Each bass guitar and 
player can produce different dynamic curves, so adjusting this parameter for an FM 
sound is essential. (You can also modify it later on the pedal with the Dynamics 
parameter.) Both sliders use a 0–127 scale. 
 
The last section in the FM editor is PITCH. The first slider is TRANSP, which 
transposes FM sounds across a four-octave range (0–48). The second slider is 



QUANTIZE, which functions as an on/off switch. When on, detected pitch is quantized 
using the Tune Base value set in the pedal’s Global parameter. It is important to tune 
the instrument to that value if you plan to use mixed sounds with FM and bass guitar or 
other instruments. With Quantize enabled, expressiveness (bending, sliding, etc.) is 
reduced, but slight finger movement or natural pitch variation of the plucked string won’t 
affect the FM sound’s pitch. Some FM sounds (pipe organ, tubular bells, harp, etc.) 
benefit from this switch. 
 
There is a new PRIORITY button in the editor that also affects the VA editor. Previously 
a two-way switch (accuracy and speed), it now includes a third option: zero, the zero-
latency mode. Zero mode can be faster and smoother than speed mode, but with new 
sounds you should experiment to find the best mode.  
 
There is also a new MODE button in the Program Display section, next to the INIT 
button. You can manually switch between VA and FM modes with it. It is duplicated in 
the File Menu. 
                        
The rest of the FM editor page is functionally the same as in the VA editor, with minor 
differences. Two parameters are grayed out with no function (VCO TRANSP and VCO 
LFO). The complete MIDI section is grayed out as well: there are no portamento, pitch 
bend, or external MIDI functions with FI FM sounds. 
 
 

The File Menu 

The File Menu is largely the same with a few new items. The first is Switching 
Between VA and FM modes. You can manually initiate a mode switch at any time 
while using the editor, but it will warn you that it will remove all currently-displayed 
programs from the Manager’s Tile Window. 
 
There are two new items for Setlist mode: Write Setlist from File to FI and Save 
Setlist from FI to File. These allow reading and saving Setlist files. There is (currently) 
no Setlist editing capability within the Editor. 
 
The Firmware Update part of the File Menu has changed slightly; prompts help with the 
update procedure. These prompts are important when making the first update from 
V4.12 or earlier firmware. 

 


